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Instructions for Preparing an Emergency Action Plan in Nebraska 
 
Introduction 
Emergency Action Plans (EAPs) are important documents to have in the event of an 
emergency involving the potential failure of a high hazard dam. It is critical that the 
information contained in an EAP is accurate, current, and easy to find in the event of an 
emergency so that people at risk can be effectively warned and evacuated. 
 
While at first glance it may appear that preparation of an EAP is a time consuming task, this 
guide has been prepared to streamline the process and help you through each step.  A fillable 
EAP template in Microsoft® Word format, which is available in the Dam Safety section of 
DNR’s website (http://dnr.nebraska.gov/dam/EAP), has been prepared for your use so you 
can essentially “fill-in-the-blanks”.  As you can see, most of the pages only have a few pieces 
of information that need to be filled in.   
 
Prior to starting the preparation of your EAP, it is a good idea to contact DNR.  The dam 
safety engineers at DNR are more than willing to help you through the process.  If you live in 
a community or county with several high hazard dams, most of the local government 
information may have already been collected for another EAP.  DNR may be able to provide 
you an example of an EAP that has already been prepared in your community, which will 
save you a significant amount of time when you start gathering information.   If you are 
having trouble finding any information or have any other questions, please feel free to 
contact:  

Thomas G. Schuerman, P.E. 
Dam Safety Engineer 

402-471-1222 
tom.schuerman@nebraska.gov 

 
Listed below are suggested steps to assist you in preparing an EAP. 
 
Step 1: Familiarize Yourself with the Fillable EAP Template. 
Take some time to read through the EAP Template and familiarize yourself with the EAP 
process.  The EAP Overview on page 3 provides a good summary of the overall EAP 
process.  In the template, the areas shaded in gray are the items that you will have to fill-
in/replace with information specific to your dam. As you read through the EAP, think about 
how the EAP can be tailored to match local conditions in your community. 
  
Unless you have good reason, you should only change the gray highlighted portions of the 
EAP template.  The EAP template was developed using national standards and has been 
adapted to match typical local government structures in Nebraska.  The template was 
developed by experts in the dam safety and the emergency response communities.  It 
represents a compilation of what have been recognized as the best EAP documents across 
various state and federal agencies and it has been updated based on “lessons learned” from 
actual dam related emergencies. 
 

http://dnr.nebraska.gov/dam/EAP
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Furthermore, it is important to have consistency in the response to dam related emergencies 
across the state, and especially across each county.  Many local agencies have several high 
hazard potential dams within their jurisdictional boundaries.  On the state level, DNR and the 
Nebraska Emergency Management Agency (NEMA) must be prepared to respond to dam 
related emergencies on over one hundred high hazard potential dams.  In order to assure a 
rapid, effective response to dam related emergencies, there must be consistency in EAP 
documents across the state.  Deviating from the EAP template could result in confusion and 
slower response times if an actual emergency were to occur at your dam. 
 
Nevertheless, there may be local conditions and local realities that make deviating from the 
standard plan necessary.  DNR recognizes that local agencies are better equipped and have a 
better understanding of what will be needed to respond to an emergency in their community.  
Therefore, DNR will accept deviations from the standard EAP template if they are done for 
legitimate reasons.  
 
Step 2: Select a Dam Observer and an Alternate Dam Observer 
The most significant role in the EAP is the role of the Dam Observer.  The Dam Observer 
must be available to inspect the dam during periods of abnormal stress, such as heavy 
rainfalls, rapid snowmelt, high sustained winds, or an earthquake.  Criteria for selecting a 
dam observer include: 
 

o Ideally, the dam observer should live at or near the dam site.  Under no 
circumstance should the dam observer live more than 10 miles from the dam. 

o The person should not be responsible for more than 2 high hazard dams.  In the 
event of heavy rainfall or an earthquake, several dams may experience emergency 
events simultaneously. 

o The person must be able to determine the appropriate emergency level if an 
emergency event is detected. 

o The person must be able to direct an emergency contractor to implement remedial 
actions that may delay, moderate, or prevent the failure of a dam.     

 
Step 3: Review the Evacuation Map for Your Dam 
All high hazard potential dams in the state are required to have an evacuation map for the 
area downstream of the dam that may be inundated if the dam should fail.  The area that may 
be inundated must be determined by a professional engineer using methods accepted by 
DNR.  The evacuation map is the most important component of any EAP as it will be the 
primary tool used by emergency personal in the case of an actual dam emergency. 
 
If you are updating or revising an EAP for an existing high hazard potential dam, then you 
should already have an evacuation map or inundation map for the dam and it can simply be 
incorporated into the new plan.  However, if (a) you are preparing an EAP for a new high 
hazard potential dam, (b) conditions at the dam or downstream of the dam have changed, (c) 
the map is not legible or unable to be copied into the new EAP, or (d) the original map was 
not prepared by a professional engineer, then a new map will need to be prepared by a 
professional engineer.  The process of hiring an engineer and preparing the evacuation map 
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may take several months.  Contact DNR if you are unsure whether your map will need to be 
updated or if you have any other questions regarding Evacuation Maps. 
 
Step 4:  Complete the EAP Worksheet 
A worksheet has been prepared to help you gather the basic information that will be needed 
to complete your EAP.  The worksheet, which is available at 
http://dnr.nebraska.gov/dam/EAP, also includes places you are likely to find the required 
information.  You should plan to meet with your local emergency manager to discuss the 
EAP and determine local resources that are available in the event of an emergency.  You can 
find the name of your local emergency manager at 
https://nema.nebraska.gov/overview/county-emergency-management-directorscoordinators. 
 
Step 5:  Collect the Required Maps and Figures 
Below is a list of maps and figures that will need to be included in the EAP.  Some of the 
figures will need to be copied from the original construction plans.  Contact DNR if you are 
unable to find the original plans for your dam.  Other maps can be prepared in ArcMap® or 
similar mapping software.  Another option is to prepare maps using DNR’s Interactive Map 
which can be accessed http://prodmaps2.ne.gov/html5DNR/?viewer=daminventory.  It 
should be anticipated that, in the future, copies will be made from the original maps you 
include in the EAP.  Consequently, all maps in the EAP should be clear, legible, and able to 
be copied.  It is also preferable if maps are in digital format so they can readily be inserted as 
images into the fillable EAP template.  Some maps and figures may have to be scanned. 
 

o State map showing general location of dam 
o Local area map or location map showing specific location of dam 
o Evacuation map (see step 3 above) 
o Plan view of dam (copy from original construction plans) 
o Profile of principal spillway (copy from original construction plans) 

 
Examples of each map are shown at the end of these instructions. 
 
 
Step 6:  Prepare Preliminary EAP 
a) Download the fillable EAP template from http://dnr.nebraska.gov/dam/EAP and save it to 

your computer.   
b) When you open the template change the view of the document on your screen to print 

layout (click the View menu to select Print Layout).  
c) Input the data gathered in step 4 above.  Any of the content of the EAP template can be 

edited; however, the gray highlighted areas contain information that must be input into 
your EAP. To insert data into these areas, simply select the gray highlighted area and 
type in your information.  After typing in your data, if the area is still highlighted, remove 
the gray highlighting (Select the text you want to remove highlighting from. On the 
Formatting Toolbar, click the arrow next to Highlight , and then click None.  If you 
don’t see the Formatting Toolbar go the View menu, click Toolbars, then click 
Formatting to bring up the Formatting Toolbar). 

http://dnr.nebraska.gov/dam/EAP
https://nema.nebraska.gov/overview/county-emergency-management-directorscoordinators
http://prodmaps2.ne.gov/html5DNR/?viewer=daminventory
http://dnr.nebraska.gov/dam/EAP
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d) Insert maps and other scanned figures.  To insert maps or other scanned files, select the 
location that you want to insert the graphic, click the Insert menu, click Insert Picture, 
then click From File.  You will then need to navigate to the folder where the maps or 
scanned drawings are located on your computer, select the appropriate file to insert, and 
then click Insert.  If you have trouble inserting a photo, map, or drawing, click the 
Format menu, then Paragraph. Make sure the Line spacing is set on single. 

e) Make sure the Roles and Responsibilities Section (pages 4 and 5) corresponds with the 
roles and responsibilities listed for each agency in the Expected Actions Section. 

f) Check the page numbers in the Table of Contents and throughout the document to make 
sure they are correct.   

g) Change the date, dam name and total number of pages (the cover sheet and final page for 
the spine of the binder should not be included in the total page count) in the headers and 
footers (double click on the header or footer and make the necessary edits.  Note if you 
change the header or footer on one page, it will change the header and footer in the entire 
document). 

h) Double check the entire document to make sure all gray highlighted areas have been 
filled in and the gray highlighting has been removed. 

 
Step 7:  Send Preliminary EAP to Local Agencies for Review 
The preliminary EAP should be sent to any local agencies that have a major role in the plan.  
The EAP must be sent to the local emergency manager for review.  Once the EAP is 
approved by DNR and finalized (Step 9), the agencies that play a major role in the EAP will 
need to sign a postcard indicating they have reviewed the plan and they concur with the tasks 
and responsibilities assigned for them and/or their organization (Steps 10 and 11). 
 
Step 8:  Collect Comments and Prepare Draft Copy 
Collect all the comments from the local agencies and make the necessary revisions to the 
EAP document.  All local issues must be resolved and any necessary local agreements must 
be obtained prior to submitting the plan to DNR for review. 
 
Step 9:  Submit the Draft EAP for Review by DNR 
After completing the draft EAP, it must be submitted to DNR at the address below.  Include 
one complete hard copy of the plan, a copy of the Microsoft® Word file on CD, and a digital 
copy (if possible) of all maps or figures that are not included in the Word file on CD.  As an 
alternative to including a CD, the digital files (less than 10 MB) can be emailed to 
tom.schuerman@nebraska.gov or tim.gokie@nebraska.gov. 
 

Department of Natural Resources 
Attn: Thomas G. Schuerman, P.E. 

301 Centennial Mall South, 4th Floor 
Lincoln, NE 68509-4676 

 
After reviewing the plan, DNR will either approve the plan or return the plan with comments.  
If the plan is returned with comments, each comment must be addressed and then the plan 
must be resubmitted to the DNR as explained above.  Please note, the dam owner must sign 
and date the cover sheet prior to submitting the final EAP to DNR. 

mailto:tom.schuerman@nebraska.gov
mailto:tim.gokie@nebraska.gov
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Step 10:  DNR Approval and Distribution 
Once DNR approves the EAP, DNR will make a copy of the plan for each of the plan holders 
listed in the EAP.  DNR will bind the copies into standard DNR-issued binders that include 
specially designed dividers and tabs for the critical sections of the EAP.   
 
When DNR distributes the EAPs, DNR will include signature postcards (two for each plan 
holder) to be signed by each plan holder and returned to the dam owner and DNR.  By 
signing the postcard, the plan holder will be indicating they have reviewed the plan and they 
concur with the tasks and responsibilities assigned for them and/or their organization. 
 
Step 11:  Collect Signature Postcards 
The dam owner shall maintain the plan holder checklist (page 24 in the fillable EAP 
template) in the EAP and keep the signature post cards in the inside front pocket of their EAP 
folder as the postcards are returned by the plan holders.  The dam owner must follow up with 
any plan holders that fail to return the signature postcards.  After all the plan holders have 
returned the postcards, the dam owner shall sign on the line at the bottom of the plan holder 
checklist and submit a copy of the checklist to the DNR. 
 
Step 12:  Review and Update EAP Annually 
It is the dam owner’s responsibility to review and update the EAP annually.  Instructions for 
updating the EAP are included in the Maintenance—EAP Review and Revision section of 
the EAP. 
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Sample Maps and Figures 
 

 
Figure 1 - Sample of state map showing general location of dam 

 
 

 
Figure 2 - Sample of local map showing specific location of dam 
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Figure 3 - Sample of evacuation map 
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Figure 4 - Sample plan view of dam (copy from original construction plans) 
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Figure 5 - Sample profile of principal spillway (copy from original construction 
plans) 


